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Introduction | Railroad free track & trace tools in a 
nutshell 

 

The Class I railroads have made an effort to provide tools for customers to gain visibility of en route rail 

shipments. The offerings vary widely across the railroads. This eBook includes reviews and tips on how to sign 

up for and use Class I railroad track & trace web site tools including: 

 Burlington Northern Sante Fe's BNSF.com 

 Canadian National Railway's Tools 

 Canadian Pacific Railway's Customer Station 

 CSX Transporation's ShipCSX 

 Norfolk Southern Railway's accessNS 

 Union Pacific Railroad's myUPRR 

Through my review of these websites, I discovered that, in general, these track & trace tools are effective 

mostly for rail shippers / receivers who are served by a single railroad with a relatively low number of 

shipments (or unit trains). There are significant weaknesses of these tools for the more prolific shipper / 

receiver, but the features may be just what you need and warrant an investigation before considering a paid 

option. Of course, the features vary by railroad and I encourage you to read the reviews above for more 

specifics so you can determine if these offerings will or will not satisfy your particular needs. Here are some 

challenges that most of the sites have: 

 Visibility of a shipment is provided only if the railroad is in the route. 

 ETAs are often only provided to interchange. 

 Historical shipment data can often only be gotten back to the beginning of the current shipment. 

 Customizing and delivering reports automatically is limited. 

 Transit time and dwell time reports usually only show measurements on that particular railroad if 

they are available at all. 

 There are no fleet management features for those who own or lease railcars such as railcar 

utilization measures, lease / sublease tracking, repair / maintenance / compliance history. 

Geez, are there any good things about these websites? Well, yes! 
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 Free... as in a box of donuts sitting in the break room. 

 Most timely, accurate and detailed data since it comes directly from the railroad's operating system. 

I recommend that you sign up for all the railroad websites upon which your traffic moves. This way, 

even if you eventually go with a paid subscription to a 3rd party system, you will always be able to 

refer back the original source if there is ever a question about the current location of a railcar. 3rd 

party systems usually collect data in batches throughout the day, so it will not be as timely as the 

railroad systems.  

NOTE: This is not necessarily true when railroad web sites are displaying data for railcar movements 

on other railroads – this data is subject to the same delays as 3rd party systems.  

 Sometimes railroad systems will also provide intermediate or intra-rail-yard moves that 3rd party 

systems can't see because the railroads don't forward that data on to outside organizations. 

 When they are available, trip plans and ETAs for the shipment should be the most up to date 

estimate of future movements of the car. 

If you are still interested in trying out a railroad website or two, keep reading to learn how to create a user 

account for each. If you are currently using some railroad websites and don’t need a new account, skip to the 

specific reviews and you may learn a new trick or two.  
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Chapter 1 | Get signed up! 
 

Are you PTW?  
Before you get too excited, you must know that your company needs to be listed as a party on the waybill in 

order to have visibility of the shipments. This is referred to as Party-To-Waybill (PTW). Typically this would 

mean that your company is a Shipper, Consignee, Care Of, and/or Freight Payer party. If your company is not 

listed on the waybill, you can still track these shipments, but it is a bit more complex: you will need to get a 

Letter of Authorization from a party that is on the waybill. Letters of Authorization can be obtained from the 

railroad ebusiness help desks. With several of the railroads, this is not too difficult. You must get the party to 

establish an online account with the railroad and then submit a letter of authorization form. 

Here are the instructions on how to get signed up for each railroad. 

 

Burlington Northern Sante Fe (BNSF) 
 

Go to http://www.bnsft.com and on the lower right corner of the page, you will see a Register button; click 

on it and you will be led through a series of questions to establish your account. 

http://www.railcartracking.com/railroad-track-trace-not-enough
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When prompted whether you already do business with BNSF, answer Yes if your company ships or receives 

carloads and BNSF moves the railcar during any part of that trip. Then place a check in the "I would like to 

register for all BNSF.com Tools" and click Next. There is a nice option where you can enter your mobile 

number and authorize BNSF to send text alerts about your shipments. You will need to enter your company 

name - be patient for this one - after you enter the first few letters, it tries to match your company with a list 

of existing companies. The search time can take a few moments. 

BNSF has an option where you can model your account to be like an account that is already set up for a co-

worker. This is a really great option and can save a lot of set up time. If you do not have any co-workers who 

have signed up already, be prepared with 1 or 2 recently shipped railcar numbers to provide to help BNSF set 

up your profile. You can request personal training too. I selected this option and a very helpful individual 

called me and walked me through the features. After you submit your request, check your email for a link to 

validate your email address. 

 

Canadian National Railway (CN) 
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An email was sent to me confirming my account with a grid showing the tools I had been given access with a 

label of "Granted". Most of the tool labels were hyperlinks leading to on-line demonstrations of the tool. 

Pretty cool. The demo of the Quick Trace tool took 3 minutes and was helpful. When I logged in this time, I 

was presented with a window requesting me to select the tools that I would like to access. I simply placed 

checks in all of the boxes below the Monitor Shipments label and clicked the Continue button. There was an 

option to have a CN eBusiness rep contact me after access had been granted. 

 

I was then taken to the Tool Home window. Under the Monitor Shipments label, it still only showed Quick 

Trace. I assumed that I would get an email in the next couple of days letting me know that I had been 

approved for the other tools. However, after logging out and logging back in immediately, I now had access 

to all of the requested tools. 
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Canadian Pacific Railway (CP) 
 

Go to http://www.cpr.ca and on the upper right corner of the page, you will see a Customer Login menu. 

Click on that menu and then click the New User? link. 

 

After logging in, you will find yourself at the Home window. On the lower right corner of the Home window, 

where you will be taken to after login, there will be a *** Welcome *** message in the Messages Centre 

window pane. This message simply says that you will need to request tools before you can really do anything 

in the account. Also, it explains how to make yourself a Central Manager if you are in a supervisory role over 

people who will be establishing online CP accounts. This will give the ability to authorize employee tool 

access. 

I clicked on the Request Tools menu and checked each option that was shipment tracking related and clicked 

the Submit button.  
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CSX Transportation (CSX) 
 

 

When you click on this link, you will be taken to http://www.shipcsx.com; click on the "Sign up for eBusiness" 

link to get your registration started. 

 

Click the "CSX Customer" link. Fill out the form. You will have the opportunity to mirror the account of a co-

worker, which is a nice feature. You will be asked to provide locations to see shipments originating / 

terminating. Enter your company name and the address(es) that you ship from or receive railcar shipments. I 

entered my headquarters and any company locations where we originate and terminate shipments where 

CSX is involved in the movement. I didn't request access to any shipping modules, since I only wanted to track 

locations of railcars. You will need to provide another person's contact information to vouch for your 

employment at the company before your account will be approved. After submitting all of my information, I 

was notified that I will receive an email with my user ID. It came within a few hours. 

 

Norfolk Southern Railway (NS) 
 

Go to http://www.nscorp.com and on the upper right corner, click the LOGIN menu. 
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Then click the REGISTER link once the menu expands. 

 

You will be taken to a form that is pretty straight forward, but you will need to name an NS sponsor, such as a 

sales representative. If you are not sure, they have a lookup tool to help you find one. Be prepared with at 

least 1 railcar number of a recent shipment that lists your company on the waybill. I did not select any of the 

applications listed, assuming that the track and trace was included in the basic account. If memory serves, my 

account was ready in less than a few days. 

 

Union Pacific Railroad (UP) 
 

Go to http://www.up.com and on the upper right corner of the page, click on the MyUPRR Login menu. You 

will see a link labeled Register; click on that. 
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When prompted, indicate that you are currently doing business with UP and accept the Terms and 

Conditions. If your company is listed on a waybill where UP moves the railcar for at least part of the 

shipment, you are considered doing business with UP. During the registration process, be prepared to have 

the commodity codes that you ship / receive. These codes can be retrieved from bills of lading / waybills and 

will be labeled "commodity" or "STCC" (Standard Transportation Commodity Code). A great place to look up 

the codes is http://www.steelroads.com; click on the Reference - Product Codes (STCC) link, click on the 

Product Codes link; you can then enter key words like "asphalt" and it will return all of the codes including 

that commodity key word. 

 

You should hear back that your account has been created within the same business day or possibly up to 3 

days if exceptions are noted. Confirmation for my account came back within an hour or so. The password 

came in the first email and the user id came in the second along with links and information about popular 

applications. I can't wait to try it! 
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Chapter 2 | Burlington Northern Santa Fe’s BNSF.com 
 

Burlington Northern Santa Fe is another Class I railroad that provides web-based tools for rail shippers and 

receivers to track their shipments. They package their railcar tracking tools into what is called BNSF.com. You 

can plan a shipment, get pricing, bill a shipment and pay for a shipment here, but this article focuses on the 

Rail Central section. If you have been thinking about using BNSF.com rail shipment tracing tools or you have 

been using just a small part of it and would like to learn more about what it can do, please read on. 

Copy and paste a list of railcars to track and trace 
After you login to BNSF.com, there will be tabs going across the top of the window and an Applications 

section on the right side of the window. It is in the Applications section where you will see a section labeled 

"Trace". Click on the link labeled "Track your Shipment". You can trace up to 300 railcars at one time. Results 

can be exported to CSV, Excel or Text. It is possible to recall the list of railcars from the last few traces (as well 

as the trace options), but there isn't an option to save and label a list of railcars. When the trace information 

is displayed, you can click on the railcar number, which is a hyperlink, and a menu displays presenting more 

hyperlinks to display such as:  

 Waybill Details 

 Shipment Details  

 Trip Plan 

 Equipment Characteristics (from Umler)  

 Unit History 

The unit history shows the last 90 days of movements on BNSF only. The waybill details will show the last 30 

days’ worth of billing. 

http://www.railcartracking.com/railroad-track-trace-not-enough
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TIP: The last reported location shown by the trace is, by default, only the last sighting on BNSF. If you click the 

railcar hyperlink and then click on Trip Plan, it will show you the movements on other railroads in the current 

trip. Another feature that will provide offline visibility: before you click the Track button, under the Include 

header, you can check the checkbox labeled "Include Foreign Line Information" to see the last reported 

location of any railcars that are on railroads other than BNSF. BNSF must be in the route for the current 

shipment to provide this offline visibility. 

Maximum history 
13 months. Click on the Home tab at the top of the window and on the lower right side of the window under 

the Applications > Manage section, you will see a link titled "Unit History". Only history while the railcar is on 

BNSF will be shown. You can filter the results by origin, destination, load / empty, waybill number or bill of 

lading number. 

ETAs 
ETAs are provided with both the Track Your Shipment as well as custom reports. The ETA will be to 

interchange point with the delivering carrier or final destination, whichever is the farthest that BNSF will be 

taking the railcar on the trip. Occasionally a shipment would show "Not Available", but this happened rarely. 

ETAs are not provided when the railcar is on a railroad other than BNSF. 

http://www.railcartracking.com/railroad-track-trace-not-enough
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Trip Plans 
The only place that I could find to display the trip plan was from the Track Your Shipment reports. When the 

records are displayed, the railcar is a hyperlink and when clicked, there is a Trip Plan hyperlink that will 

display the remaining plan when clicked. 

Unit Trains 
In the same place where you can copy and paste a list of railcars to track and trace (see above), you can click 

on the tab labeled "By Train" at the top of the window. Up to 30 trains can be tracked at once and each 

record that is returned has a hyperlink (Train ID) that when clicked will show all of the railcars currently in the 

train. The results may be exported to CSV, Excel, and Text. 

Custom Reports 
After you first login to BNSF.com, click on the tab labeled "RAIL CENTRAL" at the top of the window. Click on 

the Create New Report menu on the top left corner of the window and a separate window will open with a 

wizard that takes you through the process of creating a new report step by step. 

 Choose the type of report Carload, Carload Pipeline, or Crude by Rail. 

 Choose Template (optional); if you choose a template, then more complex options will disappear 

such as choosing your role in the shipment (shipper, consignee, etc.), 

 Choose up to 5 customer accounts (6-3-3 abbreviations) 

 Choose your company roles (maximum of 2) in the shipment (shipper, consignee, etc.). There is an 

option to include railcars that are not on BNSF. 

 Select fields for the report 

 Select filters for the report. The default tab allows you to choose Origin and/or Destination filters; 

the Advanced Search Filters tab allows you to set a lot more filters such as: 

o State / Province 

o Location (very detailed options here including direction codes, zone/track/spot, current/next 

carrier) 

o Customer. There is a lookup for the company name and then it can be assigned to the 

Shipper or Consignee filter. 

o Waybill related filters such as: waybill date range, days out, want days out, bill of lading 

number with wildcards, bond status 

o Event codes and date. You can choose one or more events to limit the report and/or the 

number 

http://www.railcartracking.com/railroad-track-trace-not-enough
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o Route including Train Symbol, Train Origin / Destination, Road - Jct (Rule 260 abbreviation) - 

Road 

o Unit initial / number / ranges; equipment length, load / empty, private / system; equipment 

request number; equipment want date. 

o Errors such as bad orders, waybill errors, contract errors 

o Commodity (STCC or description) 

o Special such as special instructions, switch codes, station hours 

 Choose sorts to add to each field and whether the grouping should be expanded or collapsed by 

default. 

 Schedule and define email recipients 

 

When the report displays in the Data View, there are menus that enable you to request services for the 

selected (check box) equipment that is currently on the BNSF. These are the same services available from the 

map feature as described below. If railcars are not on the BNSF, but BNSF is in the route for the shipment, the 

current location on the foreign road will be displayed. 

Automated Delivery of Reports 
You can do this with custom reports as explained in the section above. The scheduler is very flexible allowing 

you to select a time of day, days of the week and even an every 6, 8 or 12 hours option. 

Mapping 
For reports created in Rail Central (custom reports), after the report is displayed click on the Map View tab 

and you can see the railcar locations on a map. If you click on the Units Total number, a window will pop up 

where you can select individual railcars and then use the menus at the top of the map to send requests for 

the equipment such as: 

o Release (empty, loaded, other) 

o Order in 

o Diversions 

o Rejections 

The dots on the map indicate many different statuses as shown in the picture. 
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Transit Times & Dwell Times 
Click on the Home tab at the top of the window and on the lower right side of the window under the 

Applications > Manage section, you will see a link titled "Customer Transit Report".  You will only get results 

for revenue empty and load shipments where your company is either the shipper or consignee. Transit 

measures are only provided for the BNSF portion of the move. Thirteen months of history is provided with 

monthly, quarterly, 13 months or custom date range. When the first report displays (below), the origin-

destination pair is a hyperlink that when clicked will show more detailed charts. My favorite chart is the one 

that shows the transit time average based on the day of week the shipment originated. This would help you 

plan your shipments for the best possible performance. There are no reports available that show load / 

unload time. You can contact the BNSF demurrage team who may be able to put together a custom report 

according to the help desk. 
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Performance 
Good. A report with 635 records displayed in about 9 seconds. The rest of the application performed in a way 

that kept me engaged. 

Ease of Use 
Pretty straight forward windows, menus and buttons. The online Help (accessible by clicking on the Help 

menu in the upper right corner of each window) was a little sparse and could have provided more screen 

shots and examples. The site should feel familiar to folks accustomed to using modern web-based business 

applications. 
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Chapter 3 | Canadian National’s Tools 
Canadian National is another Class I railroad that provides web-based tools for rail shippers and receivers to 

track their shipments. They package their railcar tracking tools into what is called Tools. You can plan a 

shipment, get pricing, bill a shipment and pay for a shipment here, but this article focuses on the Monitor 

Shipments section. If you have been thinking about using CN's rail shipment tracing tools or you have been 

using just a small part of it and would like to learn more about what it can do, please read on. 

Copy and paste a list of railcars to track and trace 
The Quick Trace feature will accept up to 300 railcar IDs. After pasting or entering the IDs, you may save the 

list with a name of your choice. The output format can be set to several different layouts including two 

standardized formats that can be used to feed other business systems when the Response Type is set to 

Spreadsheet. Although the Spreadsheet radio button has a Microsoft Excel icon next to it, it is actually a 

comma separated values (CSV) formatted file. This is a good thing, since CSV files easily import into business 

systems and they open and display perfectly in Microsoft Excel. Other Response Types include Browser and 

PDF. The response will be the last reported location of each railcar in the list. As long as CN is in the route of 

the current shipment, you will have visibility of the railcar on any railroad. However, if CN is not involved in 

the current shipment, no data will be returned. 

How to get there: When you first login to the CN website, it will take you to the Tools Home page. Under the 

header "Monitor Shipments", there is a link named "Quick Trace"; click on that link and paste a list of railcars 

onto the page. 

Maximum History 
There is no feature that enables you to see back farther than the beginning of a current trip, which can be 

done with the Trip Plans feature (see below). This is a significant exclusion in my opinion. At least 1 month or 

more of history is needed to dispute demurrage charges, investigate delays, and review service performance.  

ETAs 
As with all Class I track & trace systems, ETAs to the final destination are limited. Here is a summary of the 

ETAs I was able to see, or not see, in the CN system: 

o ETA to final destination for shipments that are moving on another railroad where CN is the 

terminating carrier. 
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o No ETA for a shipment on a shortline and CN is the next carrier in the route, but not final destination 

carrier. 

o No ETA for a shipment where CN is not the terminating carrier. 

o ETA to interchange point where CN is the originating carrier and another carrier is the terminating 

carrier. 

How to see ETAs:  ETAs are shown in the Quick Trace results (see above) and the My Shipments reports if you 

include the field "ETA" in the view (see Custom Reports section below). 

TIP: There is a field named "Delivery Date" that CN says is known as a committed time of arrival. It is 

calculated based on historical data from previous trips. I assume that the CN has a statistical model that 

predicts the date of arrival to the customer's industry with a high percentage of probability. You cannot see 

this field on Quick Trace results, you will need to create a custom report on the My Shipments page (see 

Custom Report section below) and it is a field that is available when you are creating or customizing the View 

that determines which fields display on the report. There is another field available named "Delivery 

Difference", which is the difference between the ETA and Delivery Date. The ETA is generated from the trip 

plan. 

For those who are directly served by CN, a new tool has been recently created called iAdvise, which is 

comprised of the First Mile / Last Mile (FMLM) web tool and 3 email notifications: Temporary Outage 

Disruption (TOD), Local Service Notification (LSN) and Service Exception Notification (SEN). iAdvise is 

designed to provide you with information to manage your pipeline. For a very good overview of the tool, go 

to http://www.cniadvise.ca. CN has done an excellent job of providing very easy to understand descriptions 

of FMLM and the notifications, so I encourage you to go to their site to learn more. I don't have a facility that 

is served directly by CN yet, so I don't have firsthand experience to share. 

Trip Plans 
Trip Plans may be accessed either by pasting up to 20 railcar IDs onto the Trip Plan page or by clicking the 

orange icon to the far right of an individual record returned by either a My Shipments report or a Quick Trace 

report. Usually the estimated events are only the ones that happen on the CN. Sometimes, it will show a start 

of trip or end of trip event on a carrier other than CN as shown below. 

http://www.railcartracking.com/railroad-track-trace-not-enough
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How to get there: From the Tools Home page, click on the "Trip Plan" link which is below the Monitor 

Shipments heading. Or click on the orange icon to the far right of an individual record returned by either a My 

Shipments report or a Quick Trace report. 

Unit Trains 
There are no tools for carload shippers that allow tracing by train ID. 

 

Custom Reports 
My Shipments is the section that enables you to create custom reports that can be scheduled and delivered 

via email. The tricky thing about this feature is that you really can't save the report to view at a later time 

unless you schedule it. But even then, you can't run the report on demand and you can't edit the report. You 

can only alter the schedule and the recipients of the report. There are two things that you can customize that 

can be saved and re-used. The Traffic List is the basic query that pulls the shipments based on some filters: 

Shipper, Origin, Destination, Receiver, Products. You can't create or modify the Traffic List yourself, you can 
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only make a request for how you want to create / modify it. After you submit your request, you will get an 

email within a day or less telling you that the list has been created / modified. You can create a View, which 

determines which fields show on the report. You can choose from up to 26 fields. 

After you select your Traffic List and View, you can filter the report in several different ways: 

o ETA changed in the last [ 8 / 12 / 16 / 24 / 48 / 72 ] hours. 

o ETA [ Later / Earlier / Later and Earlier ] than Delivery Date by [  8 / 12 / 16 / 24 / 48 / 72 ] 

o Not Moved in [ 24 / 48 / 72 / 96 ] 

o Delayed for Repair 

o In Hold 

You can sort the report by up to two fields that are displayed on the report - with totals or without (same as 

grouping). Those sorts can be modified after the results are displayed. 

The response can be displayed in a new browser page, downloaded to a text file (fixed length records), PDF, 

or spreadsheet (it is actually comma separated values - CSV). 
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How to get there: From the Tools Home page, click on the My Shipments menu. If you schedule the report, 

then this schedule can be modified or deleted clicking on the My Reports menu from the Tools Home page. 

Automated Delivery of Reports 
After you choose the settings on the My Shipments page (see Custom Report section above), you may click 

the Schedule Report button, which will take you to the My Reports page. Up to 30 scheduled times may be 

chosen from a grid that shows 24 hours X 7 week days. You may choose an expiration date for the schedule 

or choose to keep it running until cancelled. There is a link at the bottom of the page to Update Recipients of 

the report. 

How to get there: From the Tools Home page, click on the My Reports menu. 

Mapping 
When the results are displayed from either a My Shipments custom report or Quick Trace report, you may 

choose to display the geographical location of a single railcar by clicking on the icon that looks like North 

America on the far right of the record. Unfortunately, there is no way to show more than one railcar on a 

map at one time. 

 

Transit Times & Dwell Times 
There are no ways to see summary reports that show transit time and dwell times in the CN site at this time. 
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Performance 
Most pages displayed quickly. The My Shipments page displays pretty quickly, but the drop down lists on the 

page take a few seconds to populate. Specifically, the Views and the Sort by lists are delayed and it is a little 

confusing. 

Ease of Use 
The CN website has a modern cohesive design. Each time you open a page, a tab is created for quick and easy 

navigation back to it. It is the most cohesive interface of all the railroads that I have seen so far (CSX, NS, UP, 

BNSF). Almost every page has a small question mark icon, which when clicked, reveals very helpful 

information about the page that you are on. 

Some challenges: The My Reports menu displays scheduled reports, but those reports can't be run or 

modified. The My Shipments page is used to create reports. This was a little confusing to me. Each report 

must be based on a Traffic List. The creation and modification of the Traffic List is confusing. Once you 

understand that Traffic Lists are not created or modified by you and that you can only request to create and 

modify them, things get a bit easier. 
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Chapter 4 | Canadian Pacific’s Customer Station 
Canadian Pacific is another Class I railroad that provides web-based tools for rail shippers and receivers to 

track their shipments. They package their railcar tracking tools into what is called Customer Station. You can 

bill a shipment, order railcars, manage shipments (railcar orders, diversions, placements, releases, 

demurrage, freight claims / issues), and pay for a shipment here, but this article focuses on the trace 

features. If you have been thinking about using CP's rail shipment tracing tools or you have been using just a 

small part of it and would like to learn more about what it can do, please read on. 

Copy and paste a list of railcars to track and trace 
With the Quick Trace feature, available on the Home page, you can paste or enter up to 1,000 railcar IDs 

separated by a space or a comma. Columns (fields) may be removed/added/re-ordered after the results 

display; data may be sorted by one column, but these changes will not persist to the next trace. If you want 

to keep these changes, you will need to create a Saved Report (see Custom Reports below). The results will 

display events while the railcar is on another railroad as long as CP is in the route for that shipment. The View 

column is useful for those who have facilities served by CP; it will indicate whether the railcar is in the 

pipeline (en route), in the serving area or at the facility. The More Info column includes icons to display 

additional information such as waybill, trip plan, customs or to log a problem with CP. 

Available columns include: Equipment ID, L/E, Location, Event Code, Event Description, Date/Time, 

Train/Track/Carrier, Position, Destination, ETI, ETA, Waybill (number), Content, Class Code, Car Code, 

Shipper, Consignee, Care Of, STCC, Previous STCC, Status, View, More Info. 

Results may be exported to Excel (CSV). 

 

TIP: You can copy railcar IDs from a column in Excel and they will be pasted properly for a trace without 

modification. 

How to get there: When you first login to Customer Station, you will see it in the middle right of the page. It is 

the same as the Home page. 
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Display railcar movements on other railroads 
Quick Trace, Saved Reports and Trip Plan will show sighting events on railroads other than CP as long as the 

events are part of a shipment where CP is in the route. 

Maximum history 
There isn't a feature where you can request farther back than the beginning of the current shipment; you can 

do that by viewing the Trip Plan of the current shipment (see Trip Plans below). 

ETAs 
ETAs to final destination were provided for most of my shipments whether they were on the CP or another 

railroad. There is a column titled ETI, which means estimated time of interchange. 

Trip Plans 
When you run the Quick Trace or a Saved Report (see Custom Reports section below), on the far right of 

results, there is a "More Info" link that will reveal menus to the waybill, trip plan and customs information (if 

available). The complete history will be provided for the shipment to date which will be indicated as "Actual". 

Only the CP portion of the trip will include planned events. If the trip is not finished, but the remaining 

portion is on another railroad, then you will only see the actual history up to the latest sighting event and any 

planned events that are on CP as shown below. 

 

The records may be exported to CSV/Excel. 

Unit Trains 
There is no place where you can enter a train ID for tracing. 
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Custom Reports 
You can save and schedule delivery of multiple traces filtered by either a list of railcar IDs (up to 1,000) or 

parameters such as Origin, Destination, Commodity, Load/Empty. Columns can hidden / displayed, and 

reordered. Data can be sorted by 1 column, either ascending or descending. The columns that are available, 

which are the same as those in the Quick Trace feature (mentioned above), have been greatly increased since 

the last review. The email delivery is only once per day and simply to the email address associated with the 

online account. 

How to get there: From the Home page, click on the Carload Tools > Trace Equipment menu or enjoy the new 

inclusion of the Saved Reports section on the Home page to Create a new report, Edit, or Run an existing 

report. 

Automated Delivery of Reports 
As mentioned above, from Saved Reports (Carload Tools > Trace Equipment menu) feature, you can save a 

report and then schedule it to go out once per day on any / all days of the week to just the email that is listed 

in the account profile. You can schedule up to 20 reports. 

Mapping 
There is no feature that will display the locations of rail shipments on a map. 

Transit Times & Dwell Times 
The Transit Time Report will show the time it took for the railcar to move on the CP-only segment: from when 

CP receives a railcar at origin or from another railroad to when CP delivers a railcar to the customer or 

another railroad in the route. A nice option is the ability to compare the transit performance between two 

time periods. You may also filter to just show loads or empties. The results may be exported to CSV/Excel or 

PDF. You won't see any dwell (loading / unloading) time here though; if you are served by CP, you will be able 

to get that information from the Carload Tools > View Local Event History feature. 
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How to get there: Click on the Carload Tools > Transit Time Report menu. 

Performance 
Very good. I didn't notice any significant delays. 

Ease of use 
The online help, accessed by clicking the Help link at the bottom left of each page, is very good. There are 

plenty of screen shots and good descriptions of each feature. The telephone support was friendly and helpful. 
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Chapter 5 | CSX Transportation’s ShipCSX 
CSX Transportation is one Class I railroad that provides web-based tools for rail shippers and receivers to 

track their shipments. They package their railcar tracking tools into what is called . You can plan a 

shipment, get pricing, bill a shipment and pay for a shipment here, but this article focuses on the Trace - 

Shipment Management Suite section. If you have been thinking about using ShipCSX rail shipment tracing 

tools or you have been using just a small part of it and would like to learn more about what it can do, please 

read on. 

Copy and paste a list of railcars to track and trace 
From the Shipment Management Suite page, click on the Railcar Tracking menu. You can paste up to 2,500 

railcars for an Equipment List report. If you save the report, the equipment list can be referenced for use in 

other reports too. Record formats can be set to all NITL standard CLM (car location message) formats plus a 

few CSXT proprietary formats. Output type can be set to HTML, Text (fixed length), Comma Separated Values 

(CSV). Most record formats provide only a single character sighting event code; if you click on that code when 

the initial results are returned on the web page, a small pop-up window will display the description of that 

event. For record formats like the H - NITL ETA format, an ETA Type single character code is included, which 

indicates the event for the ETA (usually J - Interchange Delivery or Z - Placement Actual); when you click on it, 

a description will display as well. If a Shipment Problem Resolution inquiry is has been created on a railcar, an 

icon will be displayed next to it when viewing tracking results with most of the tools mentioned in this article. 

 

NOTE: It is a nice option to be able to export data to a NITL standard CLM format since most third party rail 

shipment tracking systems use these formats. However, when choosing the NITL H (ETA) format with
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output type set to Text (fixed length), I noticed that the record was not formed correctly, with a slash 

between the month and day. This would prevent a system from importing the file. I checked the NITL D 

format and it was correctly formed. These two formats are very popular and should be supported by most 

systems, so I recommend using the NITL D format until the NITL H format can be corrected. CSXT is currently 

investigating this issue when this article was first published.

Display historical railcar movements on other railroads 
For Equipment List reports, you may choose to see the last reported event on all railroads, the last cycle up to 

the last reported event including all railroads, the last CSXT cycle (all events that happened on CSXT that were 

part of the latest trip), and the last 8 events on CSXT. 

Maximum history 
The Historical Equipment Trace (from the Shipment Management Suite page, click on the Historical Trace 

menu) can go back as far as 13 months. It will retrieve 30 days of history per request from the Start Date that 

is entered. You can only run this one railcar at a time as well. If you needed to get the entire 13 months of 

history, you would need to enter a Start Date of the first day of 13 months ago. For example, today is 

3/24/2016; for the first trace, enter a Start Date of 3/1/2015. The click the Next 30 days link for each 

following month. Your company must be one of the following parties on the waybill in order to use this tool: 

shipper, consignee, care of party, payer of freight. 

ETAs 
There is an option to show records in CSXT's ETA Format as well as the NITL H and I formats. These estimates 

will be for when the railcar is expected to reach either interchange with another railroad or the final 

destination, whichever comes first. 

There is a Pipeline report (from the Shipment Management Suite, click on the Pipeline & Jeopardy Reports 

menu) that shows the number of railcars, inbound or outbound, projected to arrive over the next 5 weeks (1 

week per screen). You can drill down on a particular day to show the individual railcar numbers and its 

progress in its trip. It is important to note that this report will only show ETAs for CSXT. For example, you 

would only see railcar ETAs to where CSXT delivers the railcar interchange (often referred to as ETI) to 

another railroad or to final destination only if CSXT is the delivering carrier. 
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If you are served directly by CSXT, you can set up an email or text notification of when the local train 

conductor has an ETA for when your inbound shipments will be placed at your industry. To access this 

feature, click the Ship > Notifications & Subscriptions menu. 

Trip Plans 
There is a Remaining Schedule option that will show the expected future station arrivals, departures until 

reaching the destination or interchange. It is accessed from the Results page of an equipment trace. There is 

a drop down list box, click on the down arrow and select “Remaining Schedule” from the list of options.  

Unit Trains 
You can enter a train symbol in the Train Trace section on the Railcar Tracking menu page. You may also see 

unit trains that will be used to fulfill your order in the Plan > Unit Train Management section. Click on the 

"View your unit train reservations" hyperlink or click the Shipment Pipeline menu. Once the train is loaded 

and moving, you can see the movement history of the train by: Go to Shipment Pipeline; Retrieve your 

location; Select any train ID hyperlink; within the train trace pop-up, click Show More Events hyperlink. Train 

movement history can be seen with the Train Trace feature as well. 

 

Custom reports 
From the Shipment Management Suite page, click on the Custom Reports menu. You can filter the reports by: 

 

 Customer Location (CIF), Customer Type (shipper, consignee, freight payer, Rule 11 freight payer, 

care of, pick up), 

 Load / Empty Status, 

 Origin / Destination, 

 Current Location, 

 Commodity, 
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 Billing: Bill of Lading Number (1 or many), BOL Date (range), Purchase Order (1 or many) 

 Equipment: Equipment Numbers, Equipment Lists, Car Order Types, AAR Car Types, Pool Codes 

(assigned to Customer Location(s)) 

 Events: Event Types and Special Handling 

 ETA: Early (by X hours), Late (by X hours) 

 Elapsed Time Since Last Event 

Fields can be chosen from about 100 total that will display on the report. These field combinations can be 

saved as a View. You can also save up to 3 sorts for each view. This view can then be summoned for use on 

future custom reports. 

You can choose to display the report on the Screen, Email or Download. The Output Type can be HTML, Text, 

or Comma Separated Values (CSV).  

There is a special kind of custom report called Event Notification. It has similar filtering, layout and delivery 

options, but it targeted to show railcars that have experienced specific events such as Bad Ordered, 

Constructively Placed, Placed in Hold Status, etc. You can configure it to only deliver an email if there are 

records on the report. 

Automated Delivery of Reports 
Only Custom Reports may be scheduled. Days of the week may be chosen as well as time of day (up to 6 

times per day). Delivery can be to 1 or more email addresses. Schedules expire in up to 500 days, which may 

be renewed at end of range. 

Mapping 
Custom Reports and Equipment List reports include options to show the results on a map. Once the map 

opens, you can filter the results further by load/empty status, origin, destination, hazmat (yes/no), TIH/PIH 

(yes/no), high/wide (yes/no), exception (yes/no), STCC. You may also zoom in and out. Loads are shown as 

blue dots and empties shown as yellow dots. If there are many railcars at the same location, the dot increases 

in size. If there are load and empty railcars at the same location (or in the same train), the dot is blue and 

yellow. Can view railcars on all railroads in North America. However, I had a situation where I could see one 

railcar on the BNSF, but another that was in the next state on BNSF, did not show on the map. There was no 

indication why or any error indicating that my data is incomplete. 
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Transit Times & Dwell Times 
There is a separate Help document specifically for this feature. After clicking the Transit Times menu, click the 

Transit Times User's Guide link on the upper right corner of the page. It is 100 pages. Let me try to give you 

the important highlights. Reports may be run for 1 month or 1 quarter at a time up to 1 year in the past. You 

can benefit from this feature only if your company is the shipper or consignee for the shipments. The 

measures show the time that the railcar was on CSXT only. 

Waybill Transit measures the transit from when the railcar was either waybill released or received at 

interchange from another railroad to placement at industry or interchange delivery to another railroad. You 

can compare the results against Waybill Standard, which is the average waybill transit time over the last 90 

days (excluding the current month). The results may also be compared with Waybill Schedule, which is the 

average original trip plan for all completed shipments over the last 90 days (excluding the current month). 

Event Transit measures from when the railcar was pulled from the customer's industry by CSXT or when CSXT 

receives the railcar in interchange to a terminating event such as placement at industry or delivered at 

interchange with another railroad. You can compare the results against Event Standard, which is the average 

transit time over the last 90 days (excluding the current month). 

Various dwell times can be shown such as Release to Pull, CP to Order, Order to Placement. Once you display 

the Transit Summary report, there will be a button on the upper right corner of the report that says Dwell 

View. It is a toggle. Click on it to show the dwell measurements and then click on it again to go back to the 

transit view. 
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Performance 
Overall good. A unit train of 106 railcars displayed the Equipment List report with last reported sighting in 

about 15 seconds. One to five railcars showing the last 8 sightings came back in just a couple of seconds. The 

Transit Times reports are sluggish when moving from one screen to another, and a 1 month chart took about 

30 seconds to generate, but not slow enough to be unusable. 

Ease of use 
Straight forward and simple without requiring very much review of the Help documentation. I would 

recommend watching the tutorial when you first open the Railcar Tracking page. The link for this is in the 

upper right corner. If you expect to be using the Transit Times reports extensively, I would recommend taking 

the time to read the 100 page help document. It will only take you about 1 or 2 hours to review the entire 

document since it includes a lot of screen shots and white space. Recently, ShipCSX added a new page that 

puts access to video tutorials, help topics, FAQs and latest updates all in one place - it is called the ShipCSX 

Resource Library and is accessible by clicking on the Resources > ShipCSX Resource Library menu. Getting 

personal help is easy as well. Click on the icon that looks like a person on the bottom right corner of each 

page and you will be presented with 3 menus: Feedback/Suggestions, Request Training, Ask For Help. 
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Chapter 6 | Norfolk Southern’s accessNS 
Norfolk Southern is another Class I railroad that provides web-based tools for rail shippers and receivers to 

track their shipments. They package their railcar tracking tools into what is called accessNS. You can plan a 

shipment, get pricing, bill a shipment and pay for a shipment here, but this article focuses on the Track & 

Trace section. If you have been thinking about using accessNS rail shipment tracing tools or you have been 

using just a small part of it and would like to learn more about what it can do, please read on. 

Copy and paste a list of railcars to track and trace 
When you first login to accessNS, you will see a menu for Quick Trak. Clicking on this menu will take you to a 

window where you can paste up to 1,000 railcar initial/numbers to quickly see their last reported location 

and ETA. A saved trace list of railcars can be used as well; there is a link (see red arrow on the screen print 

below) on the window labeled Stored Trace List Selection / Maintenance that when clicked will open another 

window where you can create lists of railcars. The report provides basic information such as load/empty 

status, location, event, date/time (time zone), destination, train, ETA/I (to final destination or interchange, 

whichever is first). You can drill into the last 5 days’ worth of history for each railcar by simply clicking on an 

individual record. You cannot customize this report. You cannot schedule this report for automatic delivery. If 

you want to do these things, skip to the Custom Reports section of this article. 

 

Display historical railcar movements on other railroads 
The tracing reports provided by the Tracing Applications section and the Customized Reporting Wizard show 

the last reported location of each railcar shipment where NS is in the route. If you include the Extended 
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History (EH Hyperlink) field, your reports will include a link that, when clicked, provides a pop up window of 

the last 90 days of sighting history for the particular railcar. If NS is not in the route, you can get only the last 

reported event from the Steelroads Track and Trace application provided within the accessNS Track & Trace 

solution. You may paste up to 1,000 railcars or use a saved list. The output is limited to railcar, Umler 

equipment detail drill-down link, load/empty status, location, event, date/time, train, destination, and 

railroad. 

Maximum history 
This is a quite impressive feature of accessNS. You can get history as far back as 2004. From the Track & Trace 

main menu, click on the Tracing Applications menu, then Historical Reports by Initial and Number menu, then 

the Unit History-Single Car link. This application can give you history back to 2008 by choosing an end date of 

2010 and then telling it to gather the prior 730 days of history. Enter the railcar initials / number; choose the 

end date and then the number of days of history you would like. From the Historical Reports by Initial and 

Number menu, you can also click on the Unit History Archives link that provides a query where you can get 

railcar history as far back as 2004. 

ETAs 
On Custom Reports, estimated time of arrival (to final destination) is provided when NS is the last railroad in 

the route (i.e. the railroad that will be delivering the railcar to the customer). Otherwise, an estimated time 

of interchange (ETI) to the next railroad in the route will be provided. 

Trip Plans 
When you use the Customized Reporting Wizard, see Custom Reports below, you can add a field named "TP 

Hyperlink". This will insert a hyperlink labeled "T" for each railcar record on your report. When you click the 

link, another window will open showing the scheduled arrivals / departures for the NS part of the trip. It 

includes an on-time indicator including variance of the actual vs. schedule. 
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Unit Trains 
There is a Train Inquiry menu that leads to a window where you can select a date and a train symbol to see 

the plan for that train. The plan includes the arrival / departure for each station until arriving at the 

destination or point of interchange. 

Custom Reports 
accessNS provides the Customized Reporting Wizard. This is a tool where the user can create reports to their 

own specifications including fields included, filters, sorts, title and automated delivery. There is also a window 

titled the Customized Reporting Applications which contains specialized reports customized for you by 

railroad personnel. So if you can't seem to get a report to meet your needs, be sure to contact NS before you 

give up. You can also access the Wizard from that page. 

 

Wizard Customized Reporting. There are 4 steps:  

1) Select a basic report profile as a starting point. This pre-selects fields for you. If you wish to choose the 

fields yourself, skip this step. You can also add/remove fields after choosing a profile.  

2) Select fields and filters. There are 106 fields to choose from in the Current Traffic Data table/view such as 

railcar, origin, location, destination, weight, waybill parties, commodity, etc. It is nice that there are 

hyperlinks on the results that enable drill-down to 90 day history, trip plan, Umler characteristics of the 

railcar, and detailed waybill information. If you want to filter by a particular field, you simply place a check in 

the Filter? check box next to it.  

3) Choose display options. This is where you give your report pages a title and report heading. You can even 

number the rows if you wish. You can choose to include/exclude hyperlinks to the history, Umler, waybill and 

trip plan. The coolest feature is Criteria-Based Row Coloring. The promise of this feature is that records are 
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colored based on the type of event. For example, if a railcar was bad ordered, the record would be colored 

yellow (or some other color). On the Chrome and IE web browsers, I was not able to get this to work and 

have logged the issue with NS.  

4) Save and run the report. This is where you get the chance to enter the values for the filters you requested 

in Step 2. You may also set the filter as Static or Interactive. Static is a good option if the report will be run 

automatically where the filter will never be changed. The Interactive option will prompt the user with the 

filter each time the report is run. When the report is displayed, you will have the option to sort the records 

again for the first 7 fields. 

TIP: The Page Title that you give to the report, is what will show in the subject line when emailing the report. 

TIP: When creating the report for the first time, you must display the report by clicking on the "Run/Save 

myReport" link and when the report displays, click the "Save myReport Now" link as shown below in order to 

save it so it can be run again. 

 

Automated Delivery of Reports 
After you create a report using the Customized Reporting Wizard, it is a little tricky to find where you 

schedule it for automatic delivery. 

TIP: Click the little green box next to the report when it is listed in the Customized Reporting Wizard 

Application Menu - Individual or [Company Name] Reports section to open the Scheduler page. 
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Reports may be sent to email addresses (HTML, PDF, Text, XML, Excel, CSV), a fax number, or an FTP server. 

Once the report is scheduled, the box will turn yellow and you can edit the schedule by clicking on it. 

Mapping 
No graphical mapping of shipment locations is available. 

Transit Times & Dwell Times 
There are many pre-defined, non-customizable reports available in the Tracing Applications section of 

accessNS. If you click on this menu, you will see another menu labeled "Traffic Analysis Reports". Click on the 

"Traffic Analysis Reports" menu and click on the "Customer Transit Times" link. You will need to select your 

company and then click the Continue button. The reports show the last 2 years of moves where NS was in the 

route excluding any shipments with bad orders (repairs) during the trip. This is done so that the unusual 

delay of a repair will not inflate the average transit time. This is good practice since bad orders are not 

necessarily the fault of the rail carrier and it is not representative of a typical trip. You will initially see a list of 

origins and then a list of destinations. You can see a summary of the number of shipments by month and 

commodity from/to a particular location. If you click on a destination location link such as Louisville, KY, you 

will see all shipments to that location grouped by lane, year, month, load/empty, shipper, receiver. If you 

click on the Count link, it will show you the specific shipments as shown below. 
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Click on the following links to get more information: 

 Number to see detailed history of the trip on all railroads 

 WBS to see waybill information 

 AAR to see the trip plan (only for NS portion of move) 

 STCC to see a description of the commodity 

If you want to export the report to CSV, the easiest way is to click on the "Report Destinations" link, check the 

CSV check box, enter your email address if it isn't already present and click the Process Selected Report 

Destinations button. NOTE: the transit time for this report starts at the Pulled From Patron event. 

If you click on the Lane link (on the prior report before the one shown above), it will show you a summary of 

the last two years of that particular origin / destination pair. If you scroll down, you will see some graphs. I 

think the most useful chart is the one below that shows transit trends. 
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If you scroll back up and click on the Details link for one of the month/year combinations, you will see a 

report similar to the one shown above by clicking the Details link, but it includes transit time from the 

Release event and it includes more of a summary record with just key date / times such as Constructive 

Placement, Actual Placement and Release. It includes dwell times such as constructive placement (PCON) to 

actual placement (PACT) and actual placement to release (RELS) that are useful for analyzing demurrage. 

Performance 
Overall, the screens display a lot of data relatively quickly. The loading of the Customized Reporting Wizard 

was a little slow one day - it took about 12 seconds to load the menu from the Home window. This was not 

the norm, other days it took only 2 to 3 seconds to load. 

Ease of use 
The interface is simple and mostly intuitive (i.e. I could learn most features with a little trial and error). 

Sometimes it was a little hard to use. For some of the windows, I wished that I could expand them to view 

more options at once - such as choosing fields for a custom report; it is difficult to enter the display order 

(from left to right) for each field when I can't see them all at once. The default order of the fields is based on 

the order they are selected. If you choose a profile, the order of the fields is preset and this preset was a 

good order. There are often links to tips on how to use the functionality, which are helpful. However, many 

people like to dig into a user manual and I didn't find one. On the Help menu, there is an option to chat with 
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support. I called and left a message for support (the number is on the Help menu) and they emailed me back 

the next business day. 
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Chapter 7 | Union Pacific’s MyUPRR 
Union Pacific is another Class I railroad that provides web-based tools for rail shippers and receivers to track 

their shipments. They package their railcar tracking tools into what is called MyUPRR. You can plan a 

shipment, get pricing, bill a shipment and pay for a shipment here, but this article focuses on the Trace 

section. If you have been thinking about using MyUPRR rail shipment tracing tools or you have been using 

just a small part of it and would like to learn more about what it can do, please read on. 

Copy and paste a list of railcars to track and trace 
Upon first logging in to MyUPRR, you will see the menus at the top of the window. When you click on the 

Trace > Equipment Trace menu you will have the opportunity to paste up to 300 railcar (or other equipment 

moving on the railroad) IDs. You may choose from your 10 most recent traces or a list that has been saved 

instead of pasting railcars every time. 

 

The trace results will not show the last reported event if it is on another railroad - even if UP is in the route; it 

may show an estimated time of arrival at the final destination (actual placement at industry). My experience 

is that this information was more complete for loads than empties. If the railcar is on UP, and another 

railroad will be taking the railcar to the final destination, it will show another line displaying the Estimated 

Time of Interchange (ETI) with that other railroad. 

By clicking on the More Information link for a trace record, it will expand and show Accomplished Events 

(events in the past) on all railroads in the route and the remaining Scheduled Events on the UP; the scheduled 

events on other railroads was limited. 

http://www.railcartracking.com/railroad-track-trace-not-enough


 
 
 

 
 

 
 

46 | P a g e  
 

 

From this results page, you can also perform some other actions such as create a service issue that is sent to 

UP customer service, divert the shipment, and order-in or release the railcar. 

Maximum history 
From the Ship > Waybill History menu, you can paste up to 10 railcars and retrieve up to 1 year of waybills. 

There is an option to see the movement history for each waybill including events on other railroads in the 

route. There is no way that you can enter a railcar ID and see 1 year of history all at once. To do this, you 

would need to expand the history for each waybill, copy the events (highlight all of the columns and rows by 
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dragging across the data grid from the top left corner to the bottom right corner and right mouse click and 

click the Copy menu) and paste them into a spreadsheet. The columns and rows are preserved after pasting, 

at least in Microsoft Excel. One problem with the Waybill History page is there is no way to navigate back to 

the My Home page to access the other applications other than clicking your browser back button, which is 

time consuming if you have been running a lot of queries on the Waybill History page. 

ETAs 
Estimated times of arrival can be found on the Equipment Trace (see above) and on MyReports (see Custom 

Reports section below). 

Trip Plans 
From Trace > Equipment trace results and from Custom Reports that display the Equipment ID (railcar initial / 

number) field, you will be able to click to display the Scheduled Events that remain for the trip. The scheduled 

events, if on railroads other than UP, were limited. 

Unit Trains 
From the Trace > Train Inquiry menu, you can enter a UP train ID and see its Accomplished Events and 

Scheduled Events. By clicking on the train ID link, it will open a page that shows a list of all the railcars / 

equipment on the train. This may be printed or exported to Excel. 

TIP: The Equipment Trace results has a train ID link that when clicked will take you to the summary and detail 

of the entire train as well. The page looks more updated than the Trace > Train Inquiry page and I like it 

better. 

Custom Reports 
The MyReports page gives you the ability to create new reports from scratch. This page is accessible from the 

Trace > Reports & Business Assistant menu. 

TIP: The Reports & Business Assistant is being phased out in favor of MyReports. MyReports are accessible by 

clicking on the link as shown below after you navigate to the Trace > Reports & Business Assistant page. If you 

don't see the link shown below when you first open the Reports & Business Assistant page, call UP customer 

service (from the My Home page, click on the Support > Contact Support menu to get the number and hours of 

service) and request the agent to modify your security roles to provide access to MyReports. You will have to 

log out and log back in after they make the change. This will give you more functionality so it is well worth the 

effort. 
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When you arrive on the MyReports page, click on the My Reports tab and click the "Create a New Report" 

link. The first step is to select from the 69 available fields. To filter the report, click the Filter link and click the 

Add Filter link next to the field that you wish to apply the filter - this will open a pop up window where you 

will define the filter and click the Save button. Do not click the "Select Filter at Runtime" checkbox if you are 

going to schedule the report for automatic delivery. When focus returns to the Select Filter Options page, be 

sure to scroll down and click the Save button otherwise your filter will not be applied to the report. 

You can sort by any of the 69 fields even if they do not display on the report. Up to 3 fields that display on the 

report can be used for grouping. Reports may be run or scheduled for delivery via email daily or weekly. The 

delivery times are two hour windows. 

You can choose to display the report with the map, be patient it takes a little while - my report with 5 railcars 

took about 1 minute to display. It was a little confusing since the page was blank and no progress indicator. 

There was a link labeled View Full Report, I clicked on that and the report details were displayed below the 

map. 

The report may be re-sorted after it is displayed by clicking on the arrows to the right of each field name. You 

may also enter a filter to further filter the results. There is a text box below each column title. Enter a filter 

expression such as a commodity code of "4935240" in the text box below the Commodity Code column title, 

then tab your cursor out of the text box or click the button labeled "Filters/Sorting" and the results will 

refresh limited by the newly added filter as well as any filters saved with the report. 

The Equipment ID (railcar iniitial/number) field has a drop down menu that can be clicked to display sub 

menus that may be used to divert, map, order in for placement, log a service issue, or trace, which will show 

expanded billing information as well as accomplished events of the trip and scheduled remaining events of 

the trip. 
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Reports can be shared, exported to Excel, and copied to make other reports. 

Automated Delivery of Reports 
This can be done in several different ways. My Notifications, from the Trace menu, is a handy little tool where 

you can choose to be notified via email or text when any railcars encounter a certain event such as 

Constructive Placement or Bad Order. Custom reports can be delivered via schedule - see the Custom Reports 

section above for more explanation. 

TIP: Click on the Union Pacific logo in the upper right corner of the window to return to the MyUPRR main 

menu. 

Mapping 
When tracing railcars on the Trace > Equipment page, there is a link on each individual trace record where 

you can open a map with the location of the single railcar. The default view is very close up, I would have 

preferred it to be a bit more zoomed out to get a better understanding of the location of the shipment. The 

map page is easy to read, displays quickly, shows the origin (green dot), destination (red dot), and current 

location (blue dot). This is a bit nicer than the other railroad mapping features, but I found myself really 

wanting to be able to see where all of my railcars are on the same page. To do this, you must create a custom 

report in the My Report section (see the Custom Reports section above). 
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When multiple railcars are displayed on a map, the legend is a bit different: 

 Red dot = On Train 

 Green dot = In Yard 

 Blue dot = At Industry 

 Pink dot = Offline 

 Yellow dot = Other 

 Black dot = Combo (multiple cars together) 

Here is an example of what the map will look like with multiple railcars: 
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Clicking on the dots beckons a pop up window with the name of the station city and location codes. 

Unfortunately, the railcar / equipment IDs are not listed. 

Transit Times & Dwell Times 
There are no reports that summarize transit time and dwell time per trip. 

Performance 
Throughout the system, I didn't notice too many delays. Displaying a custom report with about 50 railcars 

took about 1 minute to display and the map takes about the same amount of time with no indicator of 

progress, so be patient. 

Ease of Use 
Overall, the site is pretty easy to use and you can figure out most things without a user manual. At first the UI 

looked very modern and user friendly. However, after clicking into one of the trace applications, I felt like I 

was going back in time with a much less intuitive UI. Also, it was a little confusing on how to access the other 

applications since the menus were completely different. 

TIP: By clicking the MyUPRR logo, you will be returned to the friendly, modern UI; if that is not available, you 

will need to click on the Home menu; if that is not available then the red, white and blue Union Pacific logo 
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will take you back to the MyUPRR menu. If the MyUPRR logo is displayed and you click on the red, white and 

blue Union Pacific logo, it will take you to the UP company home page. 

You are supposed to be able to drag and drop application menus into the My Favorites section, but I was only 

able to get one application shortcut to persist in this section that way. I had better luck opening the 

application and then going back to the MyUPRR menu and dragging the application icon from the Recent 

section to the My Favorites section. You need to drag the icon barely to the right or left of the existing 

icon(s). It seems that the site is in transition with the railroad updating a few pages at a time. 
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Conclusion | What if I need more than what the railroad 
sites offer?  

As I mentioned at the beginning of this book, railroad track & trace websites are good for certain shippers / 

receivers, but as you grow and/or traffic moves on more than 1 or 2 railroads, the railroad sites may not 

provide what you need.  

Click this link to read an article that provides insight into evaluating 3rd party systems. The article provides the 

following:  

 What features do these systems typically offer?  

 How much do these systems cost?  

 How can I convince my company to spend money on a system? 

 How can I find the vendors of these systems? 
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